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If any details in this manual is unclear or if you need additional assistance setting up your laser, please feel
free to call us at +1 (626) 671-4014 or email at service@gueagle.com.

tel:+16266714014
mailto:service@gueagle.com
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Introduction

How to Use This User's Manual
Thank you for purchasing a GU Eagle laser system coming with the EagleWorks CAD/CAM software.
EagleWorks has been designed to be easy to use, but you will utilize it to its fullest potential by taking some
time to read this user's manual prior to use. You will be ready to use the software as soon as you read the first
few sections. Then you can refer to topics in the remaining sections, as you work.

Notes Used in This Manual
Look for these kinds of notes to help you find valuable information throughout the text:

NOTE

Helpful notes to keep in mind while running the laser!

IMPORTANT

Important instructions you should always follow.

WARNING

Warnings and cautions to keep in mind while running the laser.

Difference between EagleWorks and RDWorks
The EagleWorks software which comes with the customized EagleCAM laser controllers is almost the same as
the original RDWorks software which comes with the original RDCAM laser controllers, except the supported
controller models.

You can learn how to use RDWorks by this manual because the functions in RDWorks work the exact same
way as in EagleWorks, but you cannot use RDWorks with a laser equipped with an EagleCAM, and vice versa.
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Safety

Laser Safety
Lasers use intense beams of light to create heat and fire as a normal part of their operation, and depending
on the laser, the light might not be visible to you. If the proper safety measures are ignored, you could burn
or blind yourself or someone else, or start a fire that could damage or destroy the building in which the laser
system is housed.

IMPORTANT

ALWAYS wear protecting glasses while doing laser processing.

WARNING

DO NOT aim and fire laser on anything but the workpieces you want to process.

WARNING

DO NOT leave a running laser unattended.

IMPORTANT

ALWAYS follow the laser safety regulations while operating a laser directly in EagleWorks.

The visible output beam of the Laser Diode Pointer (Red Dot Pointer) is accessible to the operator. While this
device employs the same technology as the familiar laser pen-pointers, like them it is potentially hazardous if
its beam is directed into the eye.

WARNING

DO NOT view directly into the beam of the Laser Diode Pointer (Red Dot Pointer).
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Install EagleWorks
In this chapter, we will guide you to get, install and upgrade the EagleWorks software.

Get EagleWorks
Install EagleWorks
Upgrade EagleWorks
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Get EagleWorks
Before diving into the installation, you need to get the EagleWorks software package by the following ways.

1. The EagleWorks installation package comes with your CO2 lasers.

Visit our official website to get more information about our CO2 lasers.

NOTE

The blue license key is for the EaglePrint software, refer to EaglePrint User's Manual for more
information.

2. Get the latest EagleWorks installation package from our official website.

https://www.gueagle.com/
https://www.gueagle.com/
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Install EagleWorks
Before getting started, plug in the software USB flash or download the EagleWorks installation package from
our official website, refer to Get EagleWorks for more details.

1. Browse to and double click the file EagleWorksSetup_[version].exe to launch the installer, a welcome
screen appears.

2. Click Install to start the installation.

https://www.gueagle.com/
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3. A setup dialog pops up. Click Install USB driver if you plan to connect your laser by USB.

NOTE

The installer will prompt you to connect your laser by the USB cable first, it is safe to ignore it
and Windows will help you install the driver when the machine is connected the first time.

NOTE

The USB driver is not necessary if you plan to connect your laser by network.

4. Leave Type as LaserWork. Set Origin according to your laser. Set Size unit to your preference.

IMPORTANT

The option Origin MUST match the home position of your laser, otherwise, jobs will be in a
wrong coordinate system, results in mirrored or flipped cutting or engraving.
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5. Click Install to finish the installation.
A browser dialog will pop up if the option Locate install path is checked. Select a directory location,
and click OK.

6. Click Exit to close the setup dialog.

An icon for EagleWorks will be automatically added to your Desktop and Start Menu. You are now ready to use
the EagleWorks software.



rev_1.2 11 / 105

Upgrade EagleWorks
You can always download the latest EagleWorks installation package from our official website.

You can just install the new version directly without uninstalling the old version, refer to Install EagleWorks for
more details.

NOTE

You need to uninstall EagleWorks and delete the EagleWorks installation directory to completely
remove the EagleWorks software. On Windows 10, go to Settings, click Apps, uninstall the software.

On Windows 7, or if you are more familiar with the old Windows Control Panel, go to Control Panel,
click Programs and Features, uninstall the software.

https://www.gueagle.com/
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Getting Started
In this chapter, you will get familiar with the EagleWorks main user interface, learn how to connect your lasers
to EagleWorks, and get to know the basics and the workflow.

Get Familiar with the EagleWorks UI
Set up Laser Connections
Work with Offline Lasers
The Workflow
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Get Familiar with the EagleWorks UI
EagleWorks is a specialized CAD/CAM software, cooperated with the EagleCAM laser controllers, for laser
cutting and engraving. You can create simple shapes, import artworks, lay out, set and check technology, do
laser processing, all in one piece of software.

The EagleWorks main user interface is shown as below.

NOTE

You can switch the user interface language in the menu Help>Language.

Like all other CAD software, there is a big drawing window in the center. You can find the menu bar at the top,
the status bar at the bottom, and some toolbars around the drawing window. There comes the CAM part on
the right side, a set of panes which give you the technology and the settings of the current project, the job
list, the machine settings of the current laser, laser positioning and jogging functions, a set of geometry
transformation functions, and a laser panel at the bottom.
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You can hide a UI element by unchecking the corresponding item in the menu View.

System Bar
The most commonly used functions for opening or importing files, saving, panning or zooming the
view, etc, refer to Import Artworks and Panning and Zooming for more details.

System Status Bar
Information of the drawing window, the current selection, the current operation, etc.

Draw Bar
The tools for creating, editing shapes, texts and simple layout, refer to Create Simple Shapes for more
details.

Cut Property Bar
Edit geometry properties of shapes, refer to Transformations for more details.

Arrange Bar
The functions for aligning and arranging shapes, refer to Transformations for more details.

Color Bar
The colors represent the layers, and used for assigning different kinds of technology to shapes in your
design, refer to Layers for more details.
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System Work Plat
A set of panes include information, settings and functions, we will cover them in more details later.

Process Control Bar
Set up laser connections and control laser processing, refer to Set up Laser Connections and Laser Panel
for more details.
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Set up Laser Connections
Before starting jobs, you have to set up laser connections in EagleWorks.

Lasers could be connected to EagleWorks by USB or by network. There could be only one machine connected
by USB at a time, and more than one machines connected by network at the same time.

1. Connecting by USB
Connect the laser to the computer using the USB cable that comes with the machine. The connection
should be up and running immediately because the software already has a USB device set up by
default.

2. Connecting by network
There are two ways to connect lasers to the computer by network, depends on the infrastructure and
the way you work on your site.

The laser could be connected to the computer directly using the ethernet cable that comes with the
machine, just like the connection with the USB cable.

And, the laser could be connected into the sub-network you already have. In this way, you can connect
your computer wirelessly or have your workstation in another room, e.g. dedicated for job management
or designing.
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In either way, a network status prompt will appear on the control panel showing Lan ON, and you have
to set up the network, put both the laser and the computer in the same subnet to let them
communicate with each other.

Here are simple setups for example, please refer to your network administrator if there is a complex
setup on your site.

Set up network for a direct connection
The machine is set up to the IP address 192.168.1.100 by default. You can just set up a static IP
address for your computer to put them in the same subnet.
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For Windows 10 users, go to Settings, click Network & Internet.

Choose Status, click Change adapter options to open Network Connections.
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For Windows 7 users, go to Control Panel, click Network and Sharing Center.

Click Change adapter settings to open Network Connections.



rev_1.2 20 / 105

In Network Connections, double click the adapter connecting to the laser.

Scroll to and double click Internet Protocol Version 4 (TCP/IPv4) in the pop-up dialog.
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Check Use the following IP address in the pop-up dialog, set IP address to, for example,
192.168.1.99, set Subnet mask to 255.255.255.0. Click OK to finish.
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Set up network for connecting to an existing sub-network
First, set up a static IP address for the laser according to the existing subnet.

Press the button Z/U on the panel, highlight IP config+, and press the button Enter.

Set up the IP address, and press the button Enter.

Then, set up a static IP address for your computer, as described above, or get a dynamic IP
address by DHCP, according to your network preference.
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After setting up the network, set up a corresponding device in EagleWorks.

Click Setting in the section Device of Progress Control Bar, a dialog pops up, shown as below.

Click Add to bring up the dialog for setting up a new network device.

Set a name for the laser, choose Web, fill in the IP address of the machine. We recommend to click Test
to do a connection test. Click Ok if you get a successful message, then the laser will be selected as the
current one automatically and you will be good to go with it.

You can connect more than one lasers to EagleWorks by network at the same time, just remember to
assign different IP addresses for them.

If there are more than one lasers connected, make sure to select the right one in the device list before starting
jobs, because the software needs to identify the model of the laser and then generate the proper data.

NOTE

It is better to select the laser even before making designs, because some settings, e.g. the size of the
work area, will be updated automatically according to the current machine, and the software will be in
a correct configuration for your project.
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Work with Offline Lasers
We have talked about setting up laser connections in the last section, but sometimes, you just cannot connect
the laser, e.g. you have a workstation in a room which is far from the laser and without a network setup. In this
case, you can send jobs to the laser with a USB flash: make your design, save the job to a USB flash, and read
it from the laser.

There are two things you need to know when working in this way.

1. Set a correct draw area for designing
The draw area should be the exact same as the work area of the laser.

Click System Setting in the pulldown-menu Config.

In the page Configuration, you can set the draw area in the section Page size.

NOTE

The software will update the draw area automatically when the laser is connected if the option
Auto fresh page setting is checked.
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2. Choose the correct laser controller
Different lasers could be equipped with different laser controllers, you have to choose the
corresponding controller in the pulldown-menu Model to generate correct jobs.

NOTE

The controller will be chosen automatically when the laser is connected if the option Enable
auto is checked.

Refer to Laser Panel and the laser's manual for more details on how to save a job to and read a job from a
USB flash.
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The Workflow
EagleWorks is the portal between your projects and the laser. We will go through the workflow in this section.

1. Import artworks or create shapes.
2. Lay out.
3. Set technology.
4. Check technology.
5. Laser processing.

Import Artworks or Create Shapes

If you make designs in 3rd-party drawing software, e.g. Illustrator, CorelDRAW, AutoCAD, Photoshop, etc, just
import them into EagleWorks. Refer to Import Artworks for more details.

Or, you can create simple shapes directly in EagleWorks, i.e. lines, rectangles, circles, texts, etc. Refer to Create
Simple Shapes for more details.
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Lay out

Lay out, e.g. duplicate shapes as an array, nest shapes all over an area, etc. Refer to Lay out for more details.
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Set Technology

The job will be prepared after setting technology, include cutting and engraving parameters, processing
sequence, tool corrections, etc. Refer to Technology in EagleWorks for more details.
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Check Technology

You can simulate the job in EagleWorks to check technology settings. Refer to Check Technology for more
details.

Laser Processing

Now you can start the job either directly in the software or download and then control the laser on the panel.
Refer to Laser Panel for more details.
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Designs in EagleWorks
In this chapter, you will get an overview of the drawing environment, learn how to import artworks and create
shapes, how to do basic transformations, and how to lay out in EagleWorks.

Hints for Designing
Import Artworks
Create Simple Shapes
Lay out
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Hints for Designing
This section will give you an overview of the drawing environment.

Cursor

With the mouse you move the cursor over the screen. Depending on the position of the mouse and on the
function which is activated, the cursor will appear in different shapes, either as a white arrow, a crosshair, an I-
beam, etc.

Cursor Description

White arrow
The cursor is on the menu bar, the tool bars, the panels, or the drawing
window with no function activated.

Crosshair
The cursor is on the drawing window with a drawing function activated.

Black arrow
The cursor is on the drawing window with the node editing function activated.

I-beam
The cursor is on the drawing window with the text creation function activated.

Cross Arrow
The cursor is on the center handle of a selection.

 

 

Double Head Arrow
The cursor is on the surrounding handles of a selection.

Hand
The cursor is on the drawing window with the panning function activated.
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The Draw Area

The draw area is where your design is laid out, and represents the work area of the laser.

The coordinates sign shows the machine origin, and the green square shows the job origin which tells the
machine how to position the job relative to the programmed origin. Refer to Coordinates and job origin for
more details. The rulers and the grid give you a sense of where and how big a shape is.

You can change the size of the draw area, change the machine origin and the job origin, change the size unit,
change how the draw area looks like, to make it work best for you and your laser.
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Click System Setting in the pulldown-menu Config.

In the page Configuration, you can set the size of the draw area in the section Page size, which will be
updated automatically when the laser is connected and set to the current device if the option Auto fresh
page setting is checked.

IMPORTANT

If you want to set the size of the draw area different with the work area, make sure that the option
Auto fresh page setting is unchecked, and be aware that you may get unpredictable results, do it only
if you have a good reason.

You can change the machine origin by the 4-dot control in the section Homing position, and change the job
origin by the 9-dot control in the section Laser head.

IMPORTANT

The machine origin MUST match the home position of the laser, otherwise, jobs will be in a wrong
coordinate system, results in mirrored or flipped cutting or engraving.
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In the page Import/Export, you can set the size unit to millimeter or inch in the option Unit type.

NOTE

We recommend to keep the option Velocity Unit as mm/s because we give recommended processing
parameters all in mm/s.
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In the page Interface, you can set how the draw area appears in the software.
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Display

There are a few settings which control the display of the software.

Check Graph Hatch in the pulldown-menu Config, the software will display filled shapes for engraving
directly in the draw area. Refer to Engraving Parameters for more details. This takes longer than rendering the
wire outlines, and it can hide things from you behind those filled shapes that may still be sent to the laser. We
recommend to enable this only for spot-checking your work, and not for general drawing.

Uncheck Show Array in the pulldown-menu Config, all the shapes in a virtual array will be displayed as
placeholders but only the original one, which saves the software a lot of calculation time and resources. Refer
here for more details.
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Check Show Path in the pulldown-menu Edit, the software will display the traveling parts of cutting paths,
helps you figure out the start point of an outline and the processing sequence.
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Selection

You can create a selection by left clicking on the outline of a shape or by pressing and holding the left mouse
button and dragging a selection window around or across shapes.

If you drag the selection window to the right, a shape will be selected only if it is fully enclosed within the
window, as shown below.

Alternately, if you drag the selection window to the left, a shape will be selected if any part of it fall within the
window, as shown below.



rev_1.2 39 / 105

A selection can either contain a single or several shapes. With the Shift key held, you can increase a selection
by selecting more shapes. Selected shapes appear in red (cyan if they are red) with a handle in the center and
eight handles around the bounding box of the selection.

If there are shapes in different layers, refer to Layers for more details, you can right click an entry in the layer
list in the tab Work of System Work Plat to select all the shapes except texts in that layer.
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And there are a few menu commands for selection.

Menu
Command

Function
Keyboard
Shortcut

Select All Select all shapes. Ctrl + A

Select
similarity

Select all the shapes which are almost the same as the selected one but
with a tiny difference.
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Panning and Zooming

The draw area can be moved around and zoomed to help you focus on different parts of your design.

Button
Menu
Command

Function

Move Move the draw area around.

Zoom In
Zoom in the draw area from the center or the location of the mouse if it is in
the drawing window.

Zoom Out
Zoom out the draw area from the center or the location of the mouse if it is in
the drawing window.

View Page
Frame

Adapt the whole draw area to the drawing window.

View Data
Frame

Adapt the current selection to the drawing window.

View All Adapt all shapes to the drawing window.

View Select Adapt a view window to the drawing window.
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Import Artworks
EagleWorks is not intended to be a complete drawing software, you would use an external one like Illustrator,
CorelDRAW, AutoCAD, Photoshop etc. When you have an artwork ready in one of these software, the next
step is to import it into EagleWorks.

Click Import... in the pulldown-menu File, or click  to bring up the dialog Import, select a file and click
Open.

EagleWorks supports a lot of file formats, i.e. dxf, ai, plt, bmp, jpeg, etc. Not all features of every format will be
supported, for vector graphics, we recommend to use old version dxf files for better compatibility.

The artwork will be placed at the center of the draw area by default, be selected and zoomed to fit the
drawing window. And, the software may perform a set of optimizations automatically which you can adjust in
settings.
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Click System Setting in the pulldown-menu Config.

In the page Import/Export, you can change the default position to place the imported artwork in the option
Docking import data.

When importing a dxf file, make sure that the size unit in the option DXF Unit is the same as the artwork,
otherwise, you will get it in wrong scale.

For vector graphics, check the option Combine lines, the option Auto close curves and set tolerance values
to connect or close any lines or curves that are close enough or with a very small opening automatically.
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For images, check the option Import image to RDImage for doing the image processing in EagleWorks, refer
here for more details.
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Vector Graphics Optimizations

Sometimes, there are still scattered lines, curves and other sorts of issues left in the artwork after the default
optimizations of importing, it is due to that the issues exceed the range of the corrections that the
optimizations can make.

Click Data check in the pulldown-menu Handle to bring up the dialog Data check, check all the options, and
click Check, then you will get a list of issues, and all of the lines, curves and outlines with issues will be
selected automatically.

In this example, the gaps between the two curves are too big to be closed automatically.
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In these cases, you need to correct the issues manually by yourself. Here is a list of the optimization functions
which are in the pulldown-menu Handle.

Button
Menu
Command

Function

Curve auto
close

Close any lines and curves with an opening that is smaller than the tolerance
value.

Combine curve
Connect any lines and curves that are closer together than the tolerance
value.

Delete overlap Delete overlapped lines, curves and outlines.

Curve smooth Recover smooth shapes from jagged lines.

Let's go through the steps for connecting curves that are very close to each other. The other functions work
the similar way.

Select the curves which are going to be connected, and then click Combine curve in the pulldown-menu
Handle.

Set a tolerance value bigger than the size of the gap and click Ok, then the curves will be connected with each
other.

Click Measure in the pulldown-menu Tool to measure the gap if you have no idea about how big it is. Left
click on both ends of the gap, you will get the size which appears on the status bar.
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Create Simple Shapes
Instead of importing artworks, you can create simple shapes directly in EagleWorks.

Drawing

We will not cover too many details but general procedures about drawing functions in this section.

You can find all the drawing functions on the draw toolbar or in the pulldown-menu Draw, i.e. Line, Curve,
Rectangle, Ellipse, Text, etc.

Here is a list of the drawing functions.

Button Menu Command Function

Line Draw a line.

Polyline Draw a polyline.

Curve Draw a curve.

Rectangle Draw a rectangle.

Ellipse Draw an ellipse.

Text Create text.

Point Draw a point.

The Line command will create a line segment immediately when the start and end points are specified. The
Polyline command will create connected line segments, right click or press the key Esc to complete. The
polyline will be closed automatically if the end point is set to the start point. Press and hold the key Ctrl at the
same time to draw horizontal or vertical line segments.

The Curve command will create connected line segments and Bézier curves. It will start or continue a Bézier if
you add a point by pressing and holding the left mouse button and dragging a control point, and stop a
Bézier or continue a line segment if you add a point by only left clicking. Right click or press the key Esc to
complete. The curve will be closed automatically if the end point if set to the start point.
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Press and hold the left mouse button and drag to create rectangles or ellipses. Press and hold the key Ctrl at
the same time to create squares or circles. Press and hold the key Shift at the same time will drag the
rectangle or ellipse from the center, instead of the corner.

After creating, you can edit lines, curves or outlines of shapes, like moving a node point, modeling a Bézier
curve, adding or deleting a node point, converting a line to a Bézier curve or vice versa.

The Edit Node command initiates an edit and brings up the node edit toolbar. The node points of the
selection will appear, or you can click on a geometry to select it and show the nodes up. Select one or more
node points, which will appear in green, press and hold the left mouse button on a node point and drag to
move, press and hold the left mouse button on a control point and drag to model a Bézier curve, press the
key Delete to delete, click on buttons on the node edit toolbar to do other edits.

Click on somewhere on the geometry, a red square appears, to specify a point to add a node, double click on
the point or click the button Add to add the node.
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Here is a list of the functions on the node edit toolbar.

Button Function

Add a node at the specified point.

Delete the selected node.

Connect the selected two nodes.

Split the geometry from the point of the node.

Convert the segment to line.

Convert the segment to curve.

The Text command will create or change text, which is different with other vector graphics, you can not edit
its nodes but text properties, i.e. font, size, alignment and spacing, etc.

Left click somewhere on the draw area to create text, double click on an exist one to change.
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EagleWorks also supports creating text of current date and time in a self-defined format, and text of serial
numbers in self-defined format and rules.
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Transformations

The transformation functions scale, move, align, mirror or rotate shapes.

You can do a free-hand scaling by pressing and holding the left mouse button on a bounding handle of the
selection and dragging.
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You can also set a new size in Cut Property Bar or in the tab Transform of System Work Plat. The position
of the reference point will be kept when scaling.

When there are more than one shape, you can set one or some to the same width, height or size as another
by the following functions in the menu Draw>Arrange.

Button Menu Command Function

Resize width Set one or some to the same width as another object.

Resize height Set one or some to the same height as another object.

Resize size Set one or some to the same size as another object.
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You can do a free-hand moving by pressing and holding the left mouse button on the center handle of the
selection and dragging.

You can also set a new position in Cut Property Bar or in the tab Transform of System Work Plat. The
selection will be moved with the reference point standing at the new position.
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On the other hand, you can move shapes by keyboard. Press the arrow keys to move, press and hold the key
Shift at the same time to move in a bigger step. The step length can be set in settings.
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You can move shapes to a set of pre-defined positions.

Button Menu Command Function Menu Position

Data docking Move the selection to the center. Draw

Top left Move the selection to the top left. Draw>Arrange

Top right Move the selection to the top right. Draw>Arrange

Bottom right Move the selection to the bottom right. Draw>Arrange

Bottom left Move the selection to the bottom left. Draw>Arrange

Arrange Page Center Move the selection to the center. Draw>Arrange

Docking left Move the selection to the left. Draw>Arrange

Docking right Move the selection to the right. Draw>Arrange

Docking top Move the selection to the top. Draw>Arrange

Docking bottom Move the selection to the bottom. Draw>Arrange

When there are more than one shape, you can align one or some to another, or space them evenly by the
following functions in the menu Draw>Arrange.

Button Menu Command Function

Arrange left Align the left of one or some to another.

Arrange right Align the right of one or some to another.

Arrange top Align the top of one or some to another.

Arrange bottom Align the bottom of one or some to another.

Arrange Horz Center Align the vertical center of one or some to another.

Arrange Vert Center Align the horizontal center of one or some to another.

Arrange space horizontal Horizontally space the shapes evenly.

Arrange space vertical Vertically space the shapes evenly.
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You can mirror shapes horizontally or vertically by the mirror functions in the pulldown-menu Draw.

Button Menu Command Function

Horz Mirror Mirror shapes horizontally.

Vert Mirror Mirror shapes vertically.

You can also do that in the tab Transform of System Work Plat.
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Double click on a selection to switch the bounding handles, and then you can do a free-hand rotating by
pressing and holding the left mouse button on a corner handle and dragging.

You can also set a rotation angle in Cut Property Bar or in the tab Transform of System Work Plat.
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On the other hand, you can rotate shapes by keyboard. Press and hold the key Ctrl and press the arrow keys
to rotate, press and hold the key Shift at the same time to rotate in a bigger step. The step angle can be set in
settings .
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Lay out
After importing artworks or creating shapes in EagleWorks, it is time to lay them out in the draw area. You can
duplicate the selection as an array, or do nesting.

There are two kinds of arrays in EagleWorks, a concrete array, and a virtual array which includes only the
original, the real copy and nothing but the layout information of the duplications.

Click Copy Matrix in the pulldown-menu Draw or click  on Draw Bar to generate a concrete array.

Set the number of columns in XNum and the number of rows in YNum, set the column space in XSpace and

the row space in YSpace. Click  and  to change the extending direction and the pattern of the
processing sequence of the duplications. If you want the software to calculate how many columns and rows
can be put in a specific area, click Bestrew... and set the size of the area.

All the duplications in a concrete array are independent with each other, and you can select and edit one or
some of them separately.
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Click Virtual array in the tab Work of System Work Plat to generate a virtual array.

The settings for a virtual array are sort of similar with the settings for a concrete, but the best part is that you
can even change the settings after generating, e.g. change the number of columns or rows, change the
column or row space, etc.

There are two column space settings, the value at (X, space1) set the space between the duplications on an
odd column and the next, and the value at (X, space2) set the space between the duplications on an even
column and the next. The row space settings are sort of same. For example, we set 2 at (X, space1), 0 at (X,
space2), and 2 at (Y, space1), 0 at (Y, space2), then we get a 2mm gap between column 1 and 2, between
column 3 and 4, no gap between column 2 and 3, between column 4 and 5, and a 2mm gap between row 1
and 2, between row 3 and 4, no gap between row 2 and 3, shown as below.
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There are offset settings for getting a more compact layout and saving materials, the value at (X, Dislocation)
set a horizontal offset on all even rows, and the value at (Y, Dislocation) set a vertical offset on all even
columns. We usually adjust the space between rows or columns at the same time to accommodate
duplications in an area as compact as possible. For example, we set 22 at (X, Dislocation), then we get a
22mm horizontal offset on row 2 and 4, shown as below.

 

And there are mirror and flip settings also for a better layout, the option at (X, H) and (X, V) mirror and flip
duplications on all even rows, and the option at (Y, H) and (Y, V) mirror and flip duplications on all even
columns. And we also usually adjust the space between rows or columns at the same time. For example, we
check the option at (X, H), then we get the duplications on row 2 and 4 mirrored, shown as below.
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In the example below, we check the option at (Y, V), then we get the duplications on column 2 and 4 flipped,
shown as below.

 

Click  and Bestrew... for the same functions as for a concrete array.

There is essentially one and only one real copy of the shapes in a virtual array, and the array is by default a
group which can not be split up. You have to select the real copy to select the whole array, and all edits being
done on the real copy will be applied to all the other virtual duplications too.

By default, all the duplications in a virtual array appear the same way as the real copy, costs a lot of calculation
time and resources in case of a large number of complex shapes. Uncheck Show Array in the pulldown-menu
Config to let the software show only a placeholder for a virtual duplication to improve the overall
performance.
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Sometimes, it is hard to figure out the best layout solution, or it just costs you too much time to do that,
nonetheless, there comes the nesting function which is essentially an AI version of the virtual array function.

Click Nesting in the pulldown-menu Tool or click Nesting in the tab Work of System Work Plat brings up
the nesting dialog.

The best way to do nesting is to set only the safety space between each duplication and the area to fill, and
enable all the optimizations, then click Full frame to let the software figure it out on its own.
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After getting the layout solution, click Actual array or Virtual array to carry it out as a concrete or a virtual
array.
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Technology in EagleWorks
In this chapter, you will learn how to set and check technology in EagleWorks.

Important Concepts
Job Settings
Cutting Technologies
Engraving Technologies
Processing Sequence
Check Technology
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Important Concepts
So far, you are familiar with designing in EagleWorks, but you may still have questions about how the software
maps your designs to cutting and engraving. We will show you some most important concepts in this section,
to answer your questions and help you use EagleWorks properly.

1. Laser processing modes
First of all, you need to get familiar with the laser processing modes, which mean what a laser can do
on laserable materials. EagleWorks supports laser cutting and engraving, here is a definition of laser
cutting on Wikipedia.

Laser cutting is a technology that uses a laser to cut materials. Laser cutting works by directing
the output of a high-power laser most commonly through optics. A typical commercial laser for
cutting materials would involve a motion control system to follow a CNC or Gcode of the pattern
to be cut onto the material. The focused laser beam is directed at the material, which then either
melts, burns, vaporizes away, or is blown away by a jet of gas, leaving an edge with a high-
quality surface finish.
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And here is a definition of laser engraving on Wikipedia.

Laser engraving, which is a subset of laser marking, is the practice of using lasers to engrave an
object. The technique does not involve the use of inks, nor does it involve tool bits which contact
the engraving surface and wear out, giving it an advantage over alternative engraving or
marking technologies where inks or bit heads have to be replaced regularly.
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2. Vector graphics
EagleWorks supports both cutting and engraving on vector graphics, depending on the technology set
on the layer of the shapes. Here is a definition of vector graphics on Wikipedia.

Vector graphics is the use of polygons to represent images in computer graphics. Vector
graphics are based on vectors, which lead through locations called control points or nodes. Each
of these points has a definite position on the x- and y-axes of the work plane and determines
the direction of the path; further, each path may be assigned various attributes, including such
values as stroke color, shape, curve, thickness, and fill.

The example below is an artwork of our logo imported in EagleWorks, there are two layers, the black
and the blue, in this job. We set the laser processing mode of the blue to Scan, which means engraving,
and the mode of the black to Cut.

NOTE

The shapes of a layer which is set to Scan will still appear as vectors by default, check Graph
Hatch in the pulldown-menu Config to let the software display them as filled.
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3. Images
EagleWorks supports only engraving on images. Here is a definition of images on Wikipedia.

In computer graphics, a raster graphics or bitmap image is a dot matrix data structure,
representing a generally rectangular grid of pixels, or points of color, viewable via a monitor,
paper, or other display medium. Raster images are stored in image files with varying formats.

The example below is a photo of Audrey Hepburn imported in EagleWorks, in a BMP layer with the
laser processing mode set to Scan.
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Engraving with laser is much different with printing with ink, there is no color applied on materials, laser
expresses colors by etching material in different depths or densities. To map colors of an image to
different depths, we convert colors to gray scales, and then map gray scales to laser power levels. But in
practice, it is usually very difficult to control laser power precisely at a high rate of change, especially for
some kinds of laser, such as the CO2 glass laser which is widely used in laser machines. The better

choice is to map colors to different densities. A technique called halftone is often used to simulate gray
scales by the use of black dots, varying either in size or in spacing, in a result of a gradient like effect. In
the pictures below, the left one shows halftone dots, the right one shows what human eyes would see
from a distance far enough.

The example below shows the original and the halftoned photos of Audrey Hepburn.
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4. Coordinates and job origin
Every laser has a coordinate system set up on its work area, you must set up an exact same coordinate
system, called machine coordinates or absolute coordinates, on the draw area in EagleWorks to map
the laser.

Laser controllers support standard Cartesian coordinates and its variants, laser manufactures use one of
them according to their machine.
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To set up machine coordinates, click System Setting in the pulldown-menu Config, in the page
Configuration, use the 4-dots control in the section Homing position to set the position of the
machine origin. And then you will see a coordinate sign at the corresponding position of the draw area,
refer to The Draw Area for more details.
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In practice, people are often used to set a position in the work area from the laser, called programmed
origin, where you want your job to be aligned. And there comes the job origin in EagleWorks, which
tells the machine how to position the job relative to the programmed origin.

Click System Setting in the pulldown-menu Config, in the page Configuration, use the 9-dots control
in the section Laser head to set the job origin. And then you will see a green square at the
corresponding position of the job, refer to The Draw Area for more details.
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Job Settings
A set of appropriate job settings is one of the most important technology for getting good laser results.

Layers

There are twenty layers available in EagleWorks, which are represented by different colors and independent of
each other. A set of processing parameters, associated with a layer, will be applied automatically to the shapes
or images which are assigned to the layer.

In general, different kinds of operations on different materials with different thicknesses and surfaces require
different sets of processing parameters. In practice, we recommend to create a one-to-one mapping between

the most commonly used operations and the first few layers, e.g. 3mm acrylic cutting to layer , 5mm

plywood cutting to layer , and temporarily assign other operations to the last few layers when necessary,

e.g. 2mm cardboard cutting to layer . When setting processing parameters, all you need to do is just
assigning the shapes to the layers.

To assign a shape to a layer, select the shape and then click on the color of the layer.
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Sometimes, if you want to process just a part of your design, select those shapes which you want to ignore
and assign them to the layer set to be ignored.

You can also check the option Output select graphics in Process Control Bar to do the same thing, refer to
Laser Panel for more details.

There is a list of all the layers in your design in the tab Work of System Work Plat.

You can get some basic information in the view, i.e. the processing mode of a layer, whether the shapes of a
layer will be processed, whether the shapes of a layer will be displayed. Double click on the option Output or
Hide of a layer will switch its corresponding state.

By selecting a layer, you can review the speed and power settings of the layer. On a dual-laser machine, click
Laser1 to show the power of the laser 1, click Laser2 to show the power of the laser 2. You can do a quick
change by modifying the values directly here.
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Shared Layer Parameters

To set the processing parameters of a layer, there must be at least one shape in the draw area.

Double click on the layer in the layer list in the tab Work of System Work Plat, the dialog Layer Parameter
pops up.

NOTE

You can switch to another layer by clicking the color of the layer in the list on the left side without
closing the dialog and opening it from the layer list again.

There are a set of shared parameters for both cutting and engraving.

Parameter Description

Layer The color representing the layer.

Is Output Whether the shapes in the layer will be processed.

Speed The speed for cutting or engraving.

Repeat num
How many times the laser will repeat the shapes and images in
the layer.

Processing Mode Set the processing mode of the layer.
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Parameter Description

If Blowing Whether the exhaust will be turned on.

Min Power 1-6 The minimum power for cutting or engraving.

Max Power 1-6 The maximum power for cutting or engraving.

Auto synchronize when Modify laser
para

Change the power of all lasers at the same time.

On a dual-laser machine, you need to enable the power settings for the both lasers.

Sometimes, especially when cutting thin sheets in a high speed, the material will catch a lot more heat at the
start, end and sharp corners because of the low feeding speed at these positions and results in over burnt
edges. In these cases, you should set a low minimum power, e.g. just above the firing threshold, and the
software will generate a linear power curve, then the machine will adjust the power level based on the real-
time feeding speed.
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Cutting Parameters

Set Processing Mode to Cut will bring up all the cutting parameters.

Parameter Description

Seal
The length of over-cuts which may result in more smooth edges at the start and end
positions.

Open Delay
The time period after turning on the laser and before the laser head starting feeding,
helping get better edges at the start positions.

Close Delay
The time period after the laser head stopping feeding and before turning off the laser,
helping get better edges at the end positions.

Laser
through
mode

Switch the option Open Delay and Close Delay on or off.

Through
power 1-6

The power setting for Open Delay and Close Delay.
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Engraving Parameters

Set Processing Mode to Scan will bring up all the engraving parameters.

Parameter Description

Negative
Engrave

This will invert the image during engraving, effective for BMP layers only.

Optimized
Scan

Let the software calculate and set the spacing between scanlines, effective for BMP layers
only.

Output
direct

Let the machine adjust the power level based on the gray scales of the image, effective
for BMP layers only.

Independent
output

The laser will engrave each shape or image separately.

Ramp Effect
The laser will slope the sides of an engraving by varying the power level, typically used for
rubber stamps, especially if a design has thin regions that need extra support.

Ramp
Length

Control how far from the design the slope will extend.

Overstriking

Scan Mode Control how the laser carries out engraving.

Interval Control the spacing between scanlines.
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When Scan Mode is set to X_swing, the laser will sweep the material in a side-to-side pattern, engraving in
one direction and again for the return direction. When set to X_unilateralism, the laser will engrave in only
one direction and travel back to the start of the next line.

We recommend to change the unit of the option Interval to DPI, a more intuitive way of representing the
pixel density of the output, and then set the resolution value there, such as 500.
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Layer Parameter Library

The layer parameter library provides a way to store and organize presets for different operations on different
materials, and a way to quickly apply them.

To add a preset to the library, click the button Parameter library after finishing setting up parameters to
bring up the dialog Parameter library.

Click Save as, fill in a name and a note, click Ok. We recommend to name a preset in the format "[Laser
Power]-[Material Thickness]-[Material Name]-[Processing Mode]", e.g. "130W-3mm-Acrylic-Cut"
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And then you will see the new preset in the list. To load a preset into the current layer, select it and click the
button Load.
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Cutting Technologies
There are a set of technologies for cutting in EagleWorks, help you get better laser results.

Kerf Compensation

Laser kerf is the amount of material that is removed or lost in the cutting process, and, if not compensated for
in the design, will result in loose fitting parts.

Kerf width can vary depending on a number of factors, including the material, the thickness of the material,
the laser beam width and the power, the assist gas, etc.

Follow the steps below to find the exact kerf of a specific material cut with a specific group of technologies,
e.g. 3mm acrylic cut with a 130W CO2 laser, speed set to 20mm/s and power set to 85%, etc.

1. Prepare a sample of the material.
2. Set the cutting parameters.
3. Cut a 30mm x 30mm square.
4. Measure the square with a set of calipers.

The difference between the design and the actual size of the square is the kerf. For example, if the square
measures 29.80mm, then the kerf is 0.20mm.

The kerf compensation function offsets the cutting path by exact half the width of the kerf, in order to
maintain the integrity of the original part size.
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Select the drawing objects, and then select Offset polygon in the pulldown-menu Handle or click  to
bring up the dialog Offset poly.

Set Offset to exact the half the width of the kerf, choose Auto In/Out. Click Ok, the software will create new
cutting paths, which are the same distance from the original all the way around (we set a large value here to
help you easily distinguish the new cutting paths from the original). Outer contours are offset outwards and
inner contours are offset inwards.

And the software will remove the original contours if the option Delete artwork is checked.
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Limit the Cutting Speed for Small Circles

Sometimes, you have a design with both long, smooth curves and small circles. To get good cutting quality
and efficiency at the same time, you should set a high cutting speed for the whole design but limit the cutting
speed for those small circles.

Click System Setting in the pulldown-menu Config.

In the page Optimize, check the option Small circle speed limit to enable a set of cutting speed limits on
small circles with different diameters. You can also add your own rules and delete the default settings.
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Machine Settings for Cutting

There is a set of machine settings for cutting, which affects all jobs, saved in the laser controller. You can read
it from the laser if the machine is connected.

In the tab User of System Work Plat, click Read to read the settings from the laser.

The settings are in the section Cut parameters in the page Processing.

Parameter Description

Idle speed
The nominal travel speed. The actual travel speed is often lower than the nominal speed due
to the presence of acceleration and deceleration at the beginning and the end.

Idle Acc The travel acceleration.

Start
speed

The startup speed.

Min Acc The minimum cutting acceleration.

Max Acc The maximum cutting acceleration.

Idle Delay
The time after the laser head traveling to the start point of the cutting path and before
starting cutting.

Acc factor
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Parameter Description

G0 Acc
factor

Speed
factor

Key
setting

A group of presets matching your needs.

Before making changes, make sure to click Save to save the current settings in case of errors. If you have a
presets file from us, click Open to read it and update the current settings. Change the settings only if you
know what you are doing. In general, you only need to choose a preset which meet your needs, and the
software will adjust the settings in a whole and make a good match.

Preset Description

Slow cutting The slowest mode.

Precision cutting The slower mode.

General cutting The medium mode.

Speed cutting The faster mode.

Super speed cutting The fastest mode.

After changing the settings, make sure to click Write to update the settings in the laser.
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Engraving Technologies
There are a set of technologies for engraving in EagleWorks, help you get better laser results.

Processing Image

As we talked about in Important Concepts, you should map colors to different densities in order to express
them better when laser engraving an image.

Click Bitmap handle in the pulldown-menu Handle or click  to process image in EagleWorks.

If the option Import image to RDImage is not checked in the page Import/Export of the settings, the
dialog Bitmap handle pops up. We recommend to use the halftone function to process the image. Check
Dither, check Net graphic, set Frequency (number of halftone shading dots to compute per inch), and click
Apply to view to preview the result, then click Ok to confirm.
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Otherwise, the software starts the tool RDImage.

There is an intuitive workflow in the tab Picture Processing on the right side, just follow the instructions. You
can crop the image in the Step 1, adjust brightness and contrast, mirror or flip, or rotate the image in the
Step 2.
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In the Step 3, choose the material, check Invert to invert the image if necessary, and click Application to see
the processed image, then click Simulate to preview the expected results on the material.
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Click Quit Simu to quit simulation, click Import To Laser Software to confirm if the result is good, otherwise,
click Original Pic to go back to the original image and adjust the processing, then apply and check again until
you get a good result.
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Engraving Correction

Laser engraving involves high speed moving of the laser head. In this progress, laser should be triggered
simultaneously with the position control. But unfortunately, there must be some timing difference between
these two execution subsystems. In a result, each scanline will shift a little with its ideal position, which will be
even worse in a dual-direction engraving, and you will see jagged edges, shown as below.

In this figure, the black line represents the ideal position of a scanline, the blue line is the real position of a
scanline from left to right, and the green line is the real position of a scanline from right to left. In this
example, laser is triggered a little late than the position control of the laser head.

The simple way to solve this issue is to use single-direction engraving by choosing X_unilateralism in Scan
Mode in the job settings, refer here for more details. Every scanline will shift the exact same and align with
each other. But in this way, it will take much longer to finish the job compare to dual-direction engraving,
because the laser head travels back instead of engraving back.

EagleWorks has a setting to correct offsets in dual-direction engraving to balance quality and efficiency. To
use this function, you need to measure the response of your machine at a specific speed.

1. Draw a rectangle in 80mm x 10mm, set it to engraving at the speed of, for example, 400mm/s, and set
Interval to 0.5mm.

2. Laser the rectangle on a cardboard.
3. Measure the distance between the ends of the scanlines.
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Click System Setting in the pulldown-menu Config.

In the page Optimize, check the option Scanning(Reverse compensation) to enable the engraving
correction, and click the button Add... to add an entry for a specific speed.

NOTE

The reverse compensation value could be minus, depend on your laser.

Enter the speed and reverse compensation values, click Ok to confirm. You may need to do this multiple
times, making minor adjustments to get a clean result.
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Machine Settings for Engraving

There is a set of machine settings for engraving, which affects all jobs, saved in the laser controller. You can
read it from the laser if the machine is connected.

In the tab User of System Work Plat, click Read to read the settings form the laser.

The settings are in the section Sweep parameters in the page Processing.

Parameter Description

x Start Speed The startup speed when engraving along the X-axis.

y Start Speed The startup speed when engraving along the Y-axis.

x Acc The acceleration when engraving along the X-axis.

y Acc The acceleration when engraving along the Y-axis.

Line Shift Speed The shifting speed to the next scanline.

Scan Mode

Facula Size

Engraving factor
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Before making changes, make sure to click Save to save the current settings in case of errors. If you have a
presets file from us, click Open to read it and update the current settings. Change the settings only if you
know what you are doing. After changing the settings, make sure to click Write to update the settings in the
laser.
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Processing Sequence
The software will assign an initial processing order to every shape when importing or creating, e.g. 1 for the
first, 2 for the second, etc.

You can let the software process the shapes in that order, or in an optimized one which fits your needs better,
e.g. less traveling, more efficient, engraving before cutting, etc.

Click Cut optimize in the pulldown-menu Handle or click  to bring up the dialog Cutting optimize
handle.
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Here you can set the rules for generating the best processing sequence.

Rule Description

Order of layer The software will order the shapes in a layer before another.

Inside to outside The software will order the shapes inside before the ones outside.

Block handle
The software will split the whole draw area into a few narrow strips, and
order the shapes in each strip one by one.

Start point optimize
The software will try to find the optimal start point of a shape to achieve
less traveling.

Auto determine start
point and direction

The software will order shapes in a way with less traveling.

Click Ok, the software will do the optimization and give each shape a new processing order. In general, the
default settings can do a good job. Check the option Start point optimize will slow the whole process a lot if
there are a lot of shapes in the design. Check the option Order of layer if you want to process the shapes in
different layers in a specific order. Click and hold the left mouse button on a layer and drag to arrange it in
the layer list, or set the priority value directly.

If the option Path optimize is checked in Process Control Bar, the software will optimize the processing
sequence automatically.
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If you are not happy with the optimization, you can order shapes manually by yourself.

Check the option Show number to show up the current processing order on each shape. Select a shape from

the initial list on the left, click  to move it to the result list on the right. You can order the shapes one by

one, or click  to move all the shapes at a time. Click  or  to adjust the order of a shape in the result
list.

Click Ok, the software will carry out the result. Do not forget to uncheck the option Path optimize in Process
Control Bar, otherwise, the software will do the optimization again and break your result.



rev_1.2 99 / 105

Check Technology
You can check the technology settings with a simulation, to preview the path the laser will take and get a
rough idea of the final result, while getting an estimated time of how long the program will take.

Click Preview in the pulldown-menu Edit or click  to start the tool Preview.

Click Simulation to start simulating. You can control the process by clicking Pause/Continue or Stop, and
control the simulation speed by changing the value of Simulate. Right click on the simulate area and click
Config to bring up the settings dialog.
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Laser Processing
In this chapter, you will get familiar with the laser panel, learn how to use a rotary, how to manage offline jobs,
how to position and jog laser in EagleWorks.

Laser Panel
Using A Rotary
Managing Offline Jobs in EagleWorks
Positioning and Jogging in EagleWorks
Auxiliary Machine Settings
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Laser Panel
Now you can generate and output data for laser processing. You can control the processing directly in
EagleWorks, or send data to the laser as an offline job.

The processing control functions are grouped in Process Control Bar on the right side of the software.

If the option Path optimize is checked, the software will optimize the processing sequence automatically
before processing, refer to Processing Sequence for more details.

If the option Output select graphics is checked, the software will process only the selected shapes or images.
And the software will use the job origin of the selection if the option Selected graphics position is checked
at the same time.

If the laser is connected, click Start to start processing, click Pause/Continue to pause and click again to
continue, click Stop to stop processing. In this case, the job will be placed within the work area of the machine
according to the option Position, refer to Coordinates and job origin for more details.

Position Description

Current position Align the job origin to the current position of the laser head.

Anchor point Align the job origin to the programmed origin.

Machine zero Align the job origin to the machine origin.

Absolute coordinate Place the job to the corresponding position in the work area as in EagleWorks.

Click Go scale if you want to frame the job before processing. Click Cut scale if you want to cut the job down
around the frame after processing.

Click Download to send data to the laser as an offline job, and then control the processing from the panel.

If the laser is not connected, click SaveToUFile to save data into a file, and you can send it to the laser by a
USB flash, then read it and control the processing from the panel.
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Using A Rotary
To generate and output data for rotary processing, you have to enable and set up rotary first. For the
instructions on the machine side, refer to the laser's manual for more information.

In the tab User of System Work Plat, click Read to read settings from the laser machine.

In the section Rotating of the page Other, set Enable rotating to Yes, set Circle pulse to 10000 (51200 or
25600 if you have an old model), and set Diameter according to the current workpiece. Click Write to update
settings in the machine.

If it is the first time you work with a rotary, click Test to do a whole round test to check whether the Circle
pulse is correct.

Now, the software is ready for rotary processing. Just follow the workflow of the normal processing and the
software will take care of the rest.
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Managing Offline Jobs in EagleWorks
If the laser is connected, you can manage offline jobs in EagleWorks.

In the tab Doc of System Work Plat, click Read to read jobs from the laser.

You can get a brief information of each job in the list and a summary of all at the bottom. Click Process to
start, click Delete to delete, click Cal time to get the processing time of the selected job. Click Delete All to
delete all the jobs.
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Positioning and Jogging in EagleWorks
If the laser is connected, you can position or jog the laser in EagleWorks.

In the tab Test of System Work Plat, click Current Position to get the current position of the laser head.

If you want to move the laser head to a specific position, set the coordinates of the new position and then
click Moving head.

You can jog the laser by clicking X+, X-, Y+ or Y-, the laser head will move the step in the speed you set, and
move continuously if the option Continuous moving is checked.
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Auxiliary Machine Settings
There are some auxiliary machine settings you can set for the laser.

 


